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COLLEGE OF ENGINEERING ROORKEE 

 

 

Vision 
 

"To impart education in Engineering with training, skill upgradation and research in 

futuristic technologies and niche areas." 

 

 

Mission 
 

M1: To develop the professionals having basic and advanced competencies so that they can 

serve the Society & Industry, and face the global challenges.  

M2: To impart education based on latest knowledge, with analytical and experimental skills, 

through advanced methods of training, research and strong Institute-Industry interface.  

M3: To help create innovative and entrepreneurial professional.  

M4: To inculcate strong moral values for a disciplined professional growth. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

DEPARTMENT OF COMPUTER SCIENCE & ENGINEERING 
 

 

Vision 
 

To promote innovation-centric education and perform research in Computer Science and 

Engineering in pace with industrial development. 

 

Mission 
 

M1: To provide a learning environment that helps students to enhance problem solving skills 

at par with global standards. 

M2: To establish Industry-Institute Interaction to make students ready for the industrial 

environment. 

M3: To provide exposure to students to the latest tools and technologies in the area of 

computer hardware and software. 

M4: To promote research-based projects/activities in the emerging areas. 

M5: To foster the science of creativity and educating ownership for sustainable & scalable 

ventures. 

M6: To pass on the requisite moral characteristics and infuse discipline amongst the students 

to make them attain consistent elevation in their professional life. 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 
 

 



 
 

DEPARTMENT OF COMPUTER SCIENCE & ENGINEERING 
 

 

PROGRAMME EDUCATIONAL OBJECTIVES (PEOs) 
 

PEO1: To equip the students with skills and latest updated so that they can work and 

contribute to the continuously changing landscape of IT Industry. 

PEO2: To provide research-oriented education with knowledge of state-of-art analytical and 

experimental tools to enable students to pursue higher studies in institutions of repute in India 

and abroad 

PEO3: To inculcate culture of professionalism, ethical conduct, team work with good 

communication skills to enable the students to be successful in their career and enable them 

to launch start-ups in their chosen field. 

 

 

PROGRAMME SPECIFIC OUTCOME (PSOs) 
 

PSO1: Students will have the ability to apply software engineering principles to design, 

build, test, and deliver solutions for Software Industry 

PSO2: The students will be able to use programming, database, networking and web 

development concepts for developing solutions for real-life problems. 

 

   

 

 

 

 

 

 

 

 

 
 



 
 

DEPARTMENT OF INFORMATION TECHNOLOGY 

 
 

Vision 

To produce professional graduates trained in the latest tools and technologies of Information 

Technology, and to build a strong teaching & research environment that tracks and responds 

to the challenges of modern times 

 

Mission 

 

1. To impart quality engineering education that enables the students become competent IT 

professionals by providing professional technical education and training.  

2. To imbibe experiential learning blended with critical thinking and strong Industry-

connect for the students and ignite them to pursue Research in emerging areas.  

3. To establish Start-up Eco-system within the department to produce entrepreneurs. 

4. To create disciplined graduates with strong moral values who may continuously thrive for 

higher echelons in the personal and professional life.  

   



 
 

DEPARTMENT OF INFORMATION TECHNOLOGY 
 

Program Educational Objectives (PEOs) 

 

PEO No. Program Educational Objectives Statements 

PEO1 To equip the students with skills and latest updates so that they can work and 

contribute to the continuously changing landscape of IT Industry. 

PEO2 To provide good academic and research-oriented environment with knowledge of 

latest IT tools to enable students to pursue higher studies in institutions of repute in 

India and abroad. 

PEO3 To inculcate culture of professionalism, ethical conduct, team work with good 

communication skills to enable the students to be successful in their career and 

enable them to launch start-ups in their chosen field. 

 

 Program Specific Outcomes (PSOs) 

PSO1 The ability to understand, analyse and develop programming skills with the latest 

tools and technology in computing and apply standard practices, strategies in 

software development to deliver quality products and/or to pursue entrepreneur. 

PSO2 To induce continuous learning aptitude and an inclination for lifelong learning; and 

intent to act as good citizen by inculcating in them moral values & ethics. 

 

 

 

 
 

 

 

 

 

 

 

 



 
 

Program Outcomes 
 

Engineering Graduates will be able to: 
 

1. Engineering knowledge: Apply the knowledge of mathematics, science, engineering 

fundamentals, and an engineering specialization to the solution of complex engineering 

problems.  

2. Problem analysis: Identify, formulate, review research literature, and analyze complex 

engineering problems reaching substantiated conclusions using first principles of 

mathematics, natural sciences, and engineering sciences.  

3. Design/development of solutions: Design solutions for complex engineering problems and 

design system components or processes that meet the specified needs with appropriate 

consideration for the public health and safety, and the cultural, societal, and 

environmental considerations.  

4. Conduct investigations of complex problems: Use research-based knowledge and research 

methods including design of experiments, analysis and interpretation of data, and 

synthesis of the information to provide valid conclusions.  

5. Modern tool usage: Create, select, and apply appropriate techniques, resources, and 

modern engineering and IT tools including prediction and modelling to complex 

engineering activities with an understanding of the limitations.  

6. The engineer and society: Apply reasoning informed by the contextual knowledge to 

assess societal, health, safety, legal and cultural issues and the consequent responsibilities 

relevant to the professional engineering practice.  

7. Environment and sustainability: Understand the impact of the professional engineering 

solutions in societal and environmental contexts, and demonstrate the knowledge of, and 

need for sustainable development.  

8. Ethics: Apply ethical principles and commit to professional ethics and responsibilities and 

norms of the engineering practice.  

9. Individual and team work: Function effectively as an individual, and as a member or 

leader in diverse teams, and in multidisciplinary settings.  

10. Communication: Communicate effectively on complex engineering activities with the 

engineering community and with society at large, such as, being able to comprehend and 

write effective reports and design documentation, make effective presentations, and give 

and receive clear instructions.  

11. Project management and finance: Demonstrate knowledge and understanding of the 

engineering and management principles and apply these to one’s own work, as a member 

and leader in a team, to manage projects and in multidisciplinary environments.  

12. Life-long learning: Recognize the need for, and have the preparation and ability to engage 

in independent and life-long learning in the broadest context of technological change.  



 
 

GENERAL LABORATORY INSTRUCTIONS 

1. Students are advised to come to the laboratory at least 5 minutes before (to the 

starting time), those who come after 5 minutes will not be allowed into the lab. 

2. Plan your task properly much before to the commencement, come prepared to 

the lab with the synopsis / program / experiment details. 

3. Student should enter into the laboratory with: 

 Laboratory observation notes with all the details (Problem statement, Aim, 

Algorithm, Procedure, Program, Expected Output, etc.,) filled in for the lab 

session. 

 Laboratory Record updated up to the last session experiments and other 

utensils (if any) needed in the lab. 

 Proper Dress code and Identity card. 

4. Sign in the laboratory login register, write the TIME-IN, and occupy the 

computer system allotted to you by the faculty. 

5. Execute your task in the laboratory, and record the results / output in the lab 

observation note book, and get certified by the concerned faculty. 

6. All the students should be polite and cooperative with the laboratory staff, must 

maintain the discipline and decency in the laboratory. 

7. Computer labs are established with sophisticated and high end branded 

systems, which should be utilized properly. 

8. Students / Faculty must keep their mobile phones in SWITCHED OFF mode 

during the lab sessions. Misuse of the equipment, misbehaviors with the staff 

and systems etc., will attract severe punishment. 

9. Students must take the permission of the faculty in case of any urgency to go 

out; if anybody found loitering outside the lab / class without permission during 

working hours will be treated seriously and punished appropriately. 

10. Students should LOG OFF/ SHUT DOWN the computer system before he/she 

leaves the lab after completing the task (experiment) in all aspects. He/she must 

ensure the system / seat is kept properly. 

 

 

 

 

 

 

 

 

 

 



 
 

Sub Code BCSP 603 

Sub Name Data Analytics Lab 

 

COURSE OUTCOMES 
Bloom’s 

Level 

CO1 
 

Analyze data using different machine learning algorithm 
BL4 

CO2 Implement various statistical methods in Excel BL3 

CO3 Understand and use various HDFS commands BL2, BL3 

CO4 Understand and Implement various MapReduce programs BL2, BL6 

CO5 Understand and Implement Pig commands 

BL2, BL3 

 

 

 

CO-PO Matrix 

Course 

Outcome 

 
PO1 

 
PO2 

 
PO3 

 
PO4 

 
PO5 

 
PO6 

 
PO7 

 
PO8 

 
PO9 

 
PO10 

 
PO11 

 
PO12 

CO1 3 3 3 1 3      
 

3 

CO2 3 3 1 2 1 
    

  3 

CO3 2    3  
    

 2 

CO4 3 3 3 3 3  
     

2 

CO5 3 2 2 2 2  
   

    2 

Avg 2.8 2.75 2.25 2 2.4  
   

  2.4 

 

CO-PSO Matrix 

COs PSO1 PSO2 

CO1  3 

CO2   

CO3  1 

CO4 1 3 

CO5  2 

Avg 1 1.8 



 
 

Study and Evaluation Scheme 

 
Course 

Code 

Course 

Name 
Teaching Scheme Credits Assigned 

BCSP 

603 

 

Data 

Analytics 

Lab 

Theory Practical Tutorial Theory Practical Tutorial Total 

-- 02 
(50 

Marks) 

-- -- 01 -- 01 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

LIST OF PROGRAMS 

 
Subject: Data Analytics Lab                                                   Code: BCSP-603 

 
SNo Name of Experiment CO Mapping 

1 Implement and analyze Linear regression in python (Single variable & 

Multivariable) 

CO1 

2 Implement and analyze Logistic regression in python CO1 

3 Implement and analyze Decision tree algorithm in python CO1 

4 Implement and analyze Random Forest algorithm in python CO1 

5 Implementation of two samples T-test and paired two-sample T-test in 

excel. 
CO2 

6 Implementation of one-way and two-way ANOVA in excel. CO2 

7 Write steps for installing the Hadoop in windows 10 CO3 

8 Working with Hadoop commands CO3 

9 Implementation of word count example using MapReduce. CO4 

10 Implementation of MapReduce program to count unique number 

Of times a song is played based on userid and trackid. 

CO4 

 

11 Write steps for installing the Pig in windows 10. CO5 

12 Working with pig commands. CO5 

 
 

 

 

 

 

 

 

 

 

 

 



 
 

Experiment No. 1 
 

Title: Implementation of Linear regression in python (Single variable & 

Multivariable) 

 

Regression is a statistical method used in finance, investing, and other disciplines that 

attempts to determine the strength and character of the relationship between one dependent 

variable (usually denoted by Y) and a series of other variables (known as independent 

variables). 

 

1. Linear Regression Single Variable:- 

Below table represents current home prices in abc township based on square feet area 

 

   

Problem Statement: Given above data build a machine learning model that can predict home prices 

based on square feet area 

 

 

 



 
 

 

 



 
 

 
 

 

2. Linear Regression MultiVariable:- 

Now we have to predict the price of house based of many parameters like area, number 

of bedroom and age.  

The objective is to predict the price of a house based on all the above mentioned 

parameters:- 

 

 
 

 



 
 

 

 

 

Simple linear regression is a regression model that figures out the relationship 

between one independent variable and one dependent variable using a straight line.  

 

 

 

 

 



 
 

SOME APPLICATIONS WHERE WE CAN USE SIMPLE LINEAR 

REGRESSION  

1. Marks scored by students based on number of hours studied (ideally)- Here 

marks scored in exams are independent and the number of hours studied is 

independent. 

2. Predicting crop yields based on the amount of rainfall- Yield is a dependent 

variable while the measure of precipitation is an independent variable.  

3. Predicting the Salary of a person based on years of experience- Therefore, 

Experience becomes the independent while Salary turns into the dependent variable. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

Experiment No. 2 
 

 Title: Implementation of logistic regression in python. 

Logistic regression estimates the probability of an event occurring, such as voted or   

didn't vote, based on a given dataset of independent variables. Since the outcome is a 

probability, the dependent variable is bounded between 0 and 1. 

In the below given example we are predicting whether a customer will buy insurance or not 

based on his age. 

 

 



 
 

 

 



 
 

 

 
 

Applications: Logistic regression is used in various fields, including machine learning, 

most medical fields, and social sciences. For example, the Trauma and Injury Severity 

Score (TRISS), which is widely used to predict mortality in injured patients, was originally 

developed using logistic regression. Many other medical scales used to assess severity of a 

patient have been developed using logistic regression. Logistic regression is mainly used 

for binary classification though it can also be used for multiclass classification problems. 



 
 

Experiment No. 3 
 

 Title: Implementation of decision tree algorithm in python. 

 

Decision Tree is one of the most powerful and popular algorithm. Decision-tree 

algorithm falls under the category of supervised learning algorithms. It works for both 

continuous as well as categorical output variables. 

 

In this example our objective is to predict the salary of an employee based on various 

parameters. 

 

 



 
 

 

 



 
 

 
 

 

 
 



 
 

A Decision Tree is a kind of supervised machine learning algorithm that has a root node 

and leaf nodes. Every node represents a feature, and the links between the nodes show the 

decision. Every leaf represents a result. 

 

Decision Trees Applications 

 

Marketing: Businesses can use decision trees to enhance the accuracy of their promotional 

campaigns by observing the performance of their competitors’ products and services. 

Decision trees can help in audience segmentation and support businesses in producing 

better-targeted advertisements that have higher conversion rates.  

 

Retention of Customers: Companies use decision trees for customer retention through 

analyzing their behaviors and releasing new offers or products to suit those behaviors. By 

using decision tree models, companies can figure out the satisfaction levels of their 

customers as well.  

 

Diagnosis of Diseases and Ailments: Decision trees can help physicians and medical 

professionals in identifying patients that are at a higher risk of developing serious (or 

preventable) conditions such as diabetes or dementia. The ability of decision trees to 

narrow down possibilities according to specific variables is quite helpful in such cases. 
 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 



 
 

Experiment No. 4 
 

 Title: Implementation of Random Forest algorithm in python 

 

Random Forest is a popular machine learning algorithm that belongs to the supervised 

learning technique. It can be used for both Classification and Regression problems in ML. It 

is based on the concept of ensemble learning, which is a process of combining multiple 

classifiers to solve a complex problem and to improve the performance of the model. 

 

In this example we are classifying hand written digits using random forest algorithm.  

 

 
 



 
 

 

 



 
 

 

 
 

Random Forest is a classifier that contains a number of decision trees on various subsets 

of the given dataset and takes the average to improve the predictive accuracy of that 

dataset." Instead of relying on one decision tree, the random forest takes the prediction 

from each tree and based on the majority votes of predictions, and it predicts the final 

output. 

 



 
 

Applications of Random Forest 

Random forest algorithm mostly used in following areas: 

 

 Banking: Banking sector mostly uses this algorithm for the identification of loan 

risk. 

 Medicine: With the help of this algorithm, disease trends and risks of the disease 

can be identified. 

 Land Use: We can identify the areas of similar land use by this algorithm. 

 Marketing: Marketing trends can be identified using this algorithm. 

  

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

Experiment No. 5 
 

 Title: Implementation of Two sampled T-test and paired two sampled T-test in excel 

T-tests are hypothesis tests that assess the means of one or two groups. Hypothesis tests 

use sample data to infer properties of entire populations. To be able to use a t-test, you need 

to obtain a random sample from your target populations. Depending on the t-test and how you 

configure it, the test can determine whether: 

o Two group means are different. 

o Paired means are different. 

o One mean is different from a target value. 

STEPS 

1. Install the Data Analysis Tool Pack in Excel  

The Data Analysis Tool Pack must be installed on your copy of Excel to perform t-tests. To 

determine whether you have this Tool Pack installed, click Data in Excel’s menu across the 

top and look for Data Analysis in the Analyze section. If you don’t see Data Analysis, you 

need to install it.  

 

To install Excel’s Analysis Tool pack, click the File tab on the top-left and then 

click Options on the bottom-left. Then, click Add-Ins. On the Manage drop-down list, 

choose Excel Add-ins, and click Go. On the popup that appears, check Analysis Tool 

Pcak and click OK. After you enable it, click Data Analysis in the Data menu to display the 

analyses you can perform. Among other options, the popup presents three types of t-test, 

which we’ll cover next. 

 

 

https://statisticsbyjim.com/glossary/hypothesis-tests/


 
 

Two-Sample t-Tests in Excel 

Two-sample t-tests compare the means of precisely two groups—no more and no less! 

Typically, you perform this test to determine whether two population means are different. For 

example, do students who learn using Method A have a different mean score than those who 

learn using Method B? This form of the test uses independent samples. In other words, 

If the p-value is less than your significance level (e.g., 0.05), you can reject the null 

hypothesis. The difference between the two means is statistically significant. Your sample 

provides strong enough evidence to conclude that the two population means are different. 

 

Let’s assume that the variances are equal and use the Assuming Equal Variances version. If 

we had chosen the unequal variances form of the test, the steps and interpretation are the 

same—only the calculations change. 

1. In Excel, click Data Analysis on the Data tab. 

2. From the Data Analysis popup, choose t-Test: Two-Sample Assuming Equal 

Variances. 

3. Under Input, select the ranges for both Variable 1 and Variable 2. 

4. In Hypothesized Mean Difference, you’ll typically enter zero. This value is the 

null hypothesis value, which represents no effect. In this case, a mean 

difference of zero represents no difference between the two methods, which is 

no effect. 

5. Check the Labels checkbox if you have meaningful variable names in row 1. 

This option makes the output easier to interpret. Ensure that you include the 

label row in step #3. 

6. Excel uses a default Alpha value of 0.05, which is usually a good value. Alpha 

is the significance level. Change this value only when you have a specific 

reason for doing so. 

7. Click OK. 

https://statisticsbyjim.com/glossary/population/
https://statisticsbyjim.com/glossary/p-value/
https://statisticsbyjim.com/glossary/significance-level/


 
 

For the example data, your popup should look like the image below: 

 
Interpreting the Two-Sample t-Test Results 

 

The output indicates that mean for Method A is 71.50362 and for Method B it is 84.74241. 

Looking in the Variances row, we can see that they are not exactly equal, but they are close 

enough to assume equal variances. The p-value is the most important statistic. If you want to 

learn about the other statistics, you can read my posts about the t Stat (i.e., the t-value), df 

(degrees of freedom), and the t Critical values. 

If the p-value is less than your significance level, the difference between means is statistically 

significant. Excel provides p-values for both one-tailed and two-tailed t-tests. 

For our results, we’ll use P(T<=t) two-tail, which is the p-value for the two-tailed form of the 

t-test. Because our p-value (0.000336) is less than the standard significance level of 0.05, we 

can reject the null hypothesis. Our sample data support the hypothesis that the population 

means are different. Specifically, Method B’s mean is greater than Method A’s mean.  

https://statisticsbyjim.com/hypothesis-testing/interpreting-p-values/
https://statisticsbyjim.com/hypothesis-testing/t-tests-t-values-t-distributions-probabilities/
https://statisticsbyjim.com/hypothesis-testing/degrees-freedom-statistics/
https://statisticsbyjim.com/hypothesis-testing/hypothesis-tests-significance-levels-alpha-p-values/
https://statisticsbyjim.com/hypothesis-testing/hypothesis-tests-significance-levels-alpha-p-values/


 
 

Paired t-Tests in Excel 

Paired t-tests assess paired observations, which are often two measurements on the same 

person or item  

Step-by-Step Instructions for Running the Paired t-Test in Excel 

To perform a paired t-test in Excel, arrange your data into two columns so that each row 

represents one person or item, as shown below. Note that the analysis does not use the 

subject’s ID number. 

 

1. In Excel, click Data Analysis on the Data tab. 

2. From the Data Analysis popup, choose t-Test: Paired Two Sample for Means. 

3. Under Input, select the ranges for both Variable 1 and Variable 2. 

4. In Hypothesized Mean Difference, you’ll typically enter zero. This value is the null 

hypothesis value, which represents no effect. In this case, a mean difference of zero 

represents no difference between the two methods, which is no effect. 

5. Check the Labels checkbox if you have meaningful variables labels in row 1. This option 

helps make the output easier to interpret. Ensure that you include the label row in step3  

6. Excel uses a default Alpha value of 0.05, which is usually a good value. Alpha is the 

significance level. Change this value only when you have a specific reason for doing so. 

7. Click OK. 



 
 

For the example data, your popup should look like the image below: 

 

Interpreting Excel’s Paired t-Test Results 

 
The output indicates that mean for the Pertest is 97.06223 and for the Post-test it is 107.8346. 

For our results, we’ll use P(T<=t) two-tail, which is the p-value for the two-tailed form of the 

t-test. Because our p-value (0.002221) is less than the standard significance level of 0.05, we 

can reject the null hypothesis. Our sample data support the hypothesis that the population 

means are different. Specifically, the Post-test mean is greater than the Pre-test mean. 

T-test applications 

 The T-test is used to compare the mean of two samples, dependent or independent. 

 It can also be used to determine if the sample mean is different from the assumed 

mean. 

 T-test has an application in determining the confidence interval for a sample mean. 

 



 
 

Experiment No. 6 

 

 Title: Implementation of one-way and two-way ANOVA in excel. 

Analysis of Variance (ANOVA) is a statistical formula used to compare variances across the 

means (or average) of different groups. A range of scenarios use it to determine if there is any 

difference between the means of different groups. 

Creating an ANOVA table with Excel 

To perform a one way anova  implement the following step. 

 Import your data set in any preferred Excel format. 

 

 Go to the Data tab, click on the Data Analysis sub-tab. If you can’t find the sub-tab, check the 

subheading beneath. 

 Select ANOVA: single factor and click ok. 

 Click on the input range and highlight the dataset you want to use. 



 
 

 

 You can decide if you want to view it in the same spreadsheet or another spreadsheet. 

 

In our ANOVA table above, we analysed the sum of squares and other values of the ANOVA. With 

this, we can solve a one-way ANOVA using Microsoft Excel. 

 

 

 



 
 

Two-Way ANOVA 

In Excel, do the following steps: 

1. Click Data Analysis on the Data tab. 

 

2. From the Data Analysis popup, choose Anova: Two-Factor With Replication. 

 

3. Under Input, select the ranges for all columns of data. 

4. In Rows per sample, enter 20. This represents the number of observations per group. 

5. Excel uses a default Alpha value of 0.05, which is usually a good value. Alpha is the significance level. 

Change this value only when you have a specific reason for doing so. 

 

6. Click OK. 



 
 

 

Applications of Anova 

Organizations use ANOVA to make decisions about which alternative to choose among many 

possible options. For example, ANOVA can help to: 

 Compare the yield of two different wheat varieties under three different fertilizer 

brands. 

 Compare the effectiveness of various social media advertisements on the sales of a 

particular product. 

 Compare the effectiveness of different lubricants in different types of vehicles. 

 



 
 

Experiment No. 7 
 

 Title: Write steps for installing the HADOOP in windows 10 

The Apache Hadoop software library is a framework that allows for the distributed 

processing of large data sets across clusters of computers using simple programming 

models. It is designed to scale up from single servers to thousands of machines, each 

offering local computation and storage. Rather than rely on hardware to deliver high-

availability, the library itself is designed to detect and handle failures at the application 

layer, so delivering a highly-available service on top of a cluster of computers, each of 

which may be prone to failures. 

Install Java 

– Java JDK Link to download 

        https://www.oracle.com/java/technologies/javase-jdk8-downloads.html 

– extract and install Java in C:\Java 

– open cmd and type -> javac -version 

 

 

Download Hadoop 

– https://www.apache.org/dyn/closer.cgi/hadoop/common/hadoop-3.3.0/hadoop-3.3.0.tar.gz 

– extract to C:\Hadoop 

https://www.oracle.com/java/technologies/javase-jdk8-downloads.html
https://www.apache.org/dyn/closer.cgi/hadoop/common/hadoop-3.3.0/hadoop-3.3.0.tar.gz


 
 

 

1. Set the path JAVA_HOME Environment variable 

2. Set the path HADOOP_HOME Environment variable 

  
 



 
 

 

 
 

 



 
 

 

 
 

 
 



 
 

 

 
 



 
 

 
 

 

Configurations: - 

Edit file C:/Hadoop-3.3.0/etc/hadoop/core-site.xml, 

paste the xml code in folder and save 

  

<configuration> 

   <property> 

       <name>fs.defaultFS</name> 

       <value>hdfs://localhost:9000</value> 

   </property> 

</configuration> 

====================================================== 

  

Rename “mapred-site.xml.template” to “mapred-site.xml” and edit this file C:/Hadoop-

3.3.0/etc/hadoop/mapred-site.xml, paste xml code and save this file. 

  

<configuration> 

   <property> 

       <name>mapreduce.framework.name</name> 

       <value>yarn</value> 

   </property> 

</configuration> 

====================================================== 



 
 

  

Create folder “data” under “C:\Hadoop-3.3.0” 

Create folder “datanode” under “C:\Hadoop-3.3.0\data” 

Create folder “namenode” under “C:\Hadoop-3.3.0\data” 

  

====================================================== 

Edit file C:\Hadoop-3.3.0/etc/hadoop/hdfs-site.xml, 

paste xml code and save this file. 

  

<configuration> 

   <property> 

       <name>dfs.replication</name> 

       <value>1</value> 

   </property> 

   <property> 

       <name>dfs.namenode.name.dir</name> 

       <value>/hadoop-3.3.0/data/namenode</value> 

   </property> 

   <property> 

       <name>dfs.datanode.data.dir</name> 

       <value>/hadoop-3.3.0/data/datanode</value> 

   </property> 

</configuration> 

====================================================== 

  

Edit file C:/Hadoop-3.3.0/etc/hadoop/yarn-site.xml, 

paste xml code and save this file. 

  

<configuration> 

   <property> 

                <name>yarn.nodemanager.aux-services</name> 

                <value>mapreduce_shuffle</value> 

   </property> 

   <property> 

               <name>yarn.nodemanager.auxservices.mapreduce.shuffle.class</name>  

                <value>org.apache.hadoop.mapred.ShuffleHandler</value> 

   </property> 

</configuration> 

====================================================== 

  

Edit file C:/Hadoop-3.3.0/etc/hadoop/hadoop-env.cmd 

by closing the command line 

“JAVA_HOME=%JAVA_HOME%” instead of set “JAVA_HOME=C:\Java” 

  

====================================================== 

 

 

 

 



 
 

Testing: - 

 

– Open cmd and change directory to C:\Hadoop-3.3.0\sbin 

– type start-all.cmd 

 

 

 
 

– Start namenode and datanode with this command 

– type start-dfs.cmd 

– Start yarn through this command 

– type start-yarn.cmd 

 

Make sure these apps are running 

– Hadoop Namenode 

– Hadoop datanode 

– YARN Resource Manager 

– YARN Node Manager 

 
 

Open: http://localhost:8088 

http://localhost:8088/


 
 

 

  
 

====================================================== 

Hadoop installed Successfully………… 

====================================================== 

 

Applications of Hadoop 

 

Hadoop is developed by Doug Cutting and Michale J. It is managed by apache software 

foundation and licensed under the Apache license 2.0 Hadoop. It is beneficial for the big 

business because it is based on cheap servers, requiring less cost to store the data and process 

the data. Hadoop helps make a better business decision by providing a history of data and 

various company records. So by using this technology company can improve its business. 

Hadoop does lots of processing over collected data from the company to deduce the result 

which can help to make a future decision. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

Experiment No. 8 
 

 Title: Working with HADOOP commands 

Apache Hadoop is an open source framework that is used to efficiently store and process 

large datasets ranging in size from gigabytes to petabytes of data. Instead of using one large 

computer to store and process the data, Hadoop allows clustering multiple computers to 

analyze massive datasets in parallel more quickly. 

1. Version 

Hadoop HDFS version Command Usage: 

The Hadoop fs shell command version prints the Hadoop version 

 

  
 

Hadoop HDFS version Command Description: 
The Hadoop fs shell command version prints the Hadoop version. 

 

2. mkdir 

Hadoop HDFS mkdir Command Usage: 

 



 
 

Hadoop HDFS mkdir Command Description: 
This command creates the directory in HDFS if it does not already exist. 

3. ls 

Hadoop HDFS ls Command Usage: 
Here in the below example, we are using the ls command to enlist the files and directories 

present in HDFS. 

 

 
 

4. put 

Hadoop HDFS put Command Usage: 
Here in this example, we are trying to copy localfile1 of the local file system to the Hadoop 

filesystem. 

 



 
 

Hadoop HDFS put Command Description: 
The Hadoop fs shell command put is similar to the copyFromLocal, which copies files or 

directory from the local filesystem to the destination in the Hadoop filesystem. 

 

5. copyFromLocal 

Hadoop HDFS copyFromLocal Command Usage: 

Here in the below example, we are trying to copy the ‘test1’ file present in the local file 

system to the newDataFlair directory of Hadoop. 

 

Hadoop HDFS copyFromLocal Command Example: 
Here in the below example, we are trying to copy the ‘test1’ file present in the local file 

system to the newDataFlair directory of Hadoop. 

6. get 

Hadoop HDFS get Command Usage: 

In this example, we are trying to copy the ‘file’ of the hadoop filesystem to the local file 

system. 

 



 
 

Hadoop HDFS get Command Description: 
The Hadoop fs shell command get copies the file or directory from the Hadoop file system to 

the local file system. 

7. copyToLocal 

Hadoop HDFS copyToLocal Command Usage: 

Here in this example, we are trying to copy the ‘sample’ file present in the newDataFlair 

directory of HDFS to the local file system. 

 

Hadoop HDFS copyToLocal Description: 

copyToLocal command copies the file from HDFS to the local file system. 

 

8. cat 

Hadoop HDFS cat Command Usage: 

 

Here in this example, we are using the cat command to display the content of the ‘sample’ 

file present in newDataFlair directory of HDFS. 

 

https://hadoop.apache.org/docs/current/hadoop-project-dist/hadoop-common/FileSystemShell.html#get


 
 

Hadoop HDFS cat Command Description: 
The cat command reads the file in HDFS and displays the content of the file on console or 

stdout. 

 

9. mv 

 
 

Hadoop HDFS mv Command Description: 

 

The HDFS mv command moves the files or directories from the source to a destination 

within HDFS. 

 

10. cp 

 
 

 

Hadoop HDFS cp Command Description: 

 

The cp command copies a file from one directory to another directory within the HDFS. 

 

 

https://data-flair.training/blogs/comprehensive-hdfs-guide-introduction-architecture-data-read-write-tutorial/


 
 

Experiment No. 9 
 

  Title: Implementation of word count example using MapReduce. 

In MapReduce word count example, we find out the frequency of each word. Here, the role 

of Mapper is to map the keys to the existing values and the role of Reducer is to aggregate the 

keys of common values. So, everything is represented in the form of Key-value pair. 

package wordcount2; 

 

import java.io.IOException; 

import java.util.*; 

import org.apache.hadoop.fs.Path; 

import org.apache.hadoop.conf.*; 

import org.apache.hadoop.io.*; 

import org.apache.hadoop.mapreduce.*; 

import org.apache.hadoop.mapreduce.lib.input.FileInputFormat; 

import org.apache.hadoop.mapreduce.lib.input.TextInputFormat; 

import org.apache.hadoop.mapreduce.lib.output.FileOutputFormat; 

import org.apache.hadoop.mapreduce.lib.output.TextOutputFormat; 

public class Wordcount2 { 

 

  public static class Map extends Mapper<LongWritable, Text, Text, IntWritable> { 

    private final static IntWritable one = new IntWritable(1); 

    private Text word = new Text(); 

    public void map(LongWritable key, Text value, Context context) throws IOException, 

InterruptedException { 

        String line = value.toString(); 

        StringTokenizer tokenizer = new StringTokenizer(line); 

        while (tokenizer.hasMoreTokens()) { 

            word.set(tokenizer.nextToken()); 

            context.write(word, one); 

        } 

    } }  

         

 public static class Reduce extends Reducer<Text, IntWritable, Text, IntWritable> { 

 

    public void reduce(Text key, Iterable<IntWritable> values, Context context)  

      throws IOException, InterruptedException { 

        int sum = 0; 

        for (IntWritable val : values) { 

            sum += val.get(); 

        } 

        context.write(key, new IntWritable(sum)); 

    } 

 } 

         

 public static void main(String[] args) throws Exception { 

    Configuration conf = new Configuration(); 



 
 

        Job job = new Job(conf, "Wordcount2"); 

    job.setJarByClass(Wordcount2.class); 

        job.setJobName("WordCounter"); 

    job.setOutputKeyClass(Text.class); 

    job.setOutputValueClass(IntWritable.class); 

         

    job.setMapperClass(Map.class); 

    job.setReducerClass(Reduce.class); 

         

    job.setInputFormatClass(TextInputFormat.class); 

    job.setOutputFormatClass(TextOutputFormat.class); 

         

    FileInputFormat.addInputPath(job, new Path(args[0])); 

    FileOutputFormat.setOutputPath(job, new Path(args[1])); 

         

    job.waitForCompletion(true); 

 }        

} 

Input File 

 
 

Output File 

 
 



 
 

Experiment No. 10 
 

 Title: Implementation of MapReduce program to count unique number Of times a song 

is played based on userid and trackid. 

package tempex; 

import java.io.IOException; 

import java.util.*; 

         

import org.apache.hadoop.fs.Path; 

import org.apache.hadoop.conf.*; 

import org.apache.hadoop.io.*; 

import org.apache.hadoop.mapreduce.*; 

import org.apache.hadoop.mapreduce.lib.input.FileInputFormat; 

import org.apache.hadoop.mapreduce.lib.input.TextInputFormat; 

import org.apache.hadoop.mapreduce.lib.output.FileOutputFormat; 

import org.apache.hadoop.mapreduce.lib.output.TextOutputFormat; 

public class Tempex { 

 

public static class UniqueListenersMapper extends 

Mapper<Object,Text,IntWritable,IntWritable>{ 

        IntWritable trackId = new IntWritable(); 

        IntWritable userId = new IntWritable(); 

  

public void map(Object key, Text value,Context context) 

        throws IOException, InterruptedException { 

  

    String[] parts = value.toString().split("[|]"); 

    trackId.set(Integer.parseInt(parts[1])); 

    userId.set(Integer.parseInt(parts[0])); 

                context.write(trackId, userId); 

    } 

} 

 

public static class UniqueListenersReducer extends 

    Reducer< IntWritable , IntWritable, IntWritable, IntWritable> { 

    public void reduce( 

        IntWritable trackId, 

        Iterable< IntWritable > userIds,Context context) throws IOException, 

InterruptedException  

    { 

        Set< Integer > userIdSet = new HashSet< Integer >(); 

        for (IntWritable userId : userIds) { 

        userIdSet.add(userId.get()); 

        } 

        IntWritable size = new IntWritable(userIdSet.size()); 

        context.write(trackId, size); 

    } 

} 



 
 

 

 

public static void main(String[] args) throws Exception { 

        Configuration conf = new Configuration(); 

        if (args.length != 2) { 

            System.err.println("Usage: uniquelisteners < in > < out >"); 

            System.exit(2); 

        } 

        Job job = new Job(conf, "Unique listeners per track"); 

        job.setJarByClass(Tempex.class); 

        job.setMapperClass(UniqueListenersMapper.class); 

        job.setReducerClass(UniqueListenersReducer.class); 

        job.setOutputKeyClass(IntWritable.class); 

        job.setOutputValueClass(IntWritable.class); 

        FileInputFormat.addInputPath(job, new Path(args[0])); 

        FileOutputFormat.setOutputPath(job, new Path(args[1])); 

        System.exit(job.waitForCompletion(true) ? 0 : 1); 

         

} 

} 

 

Input 

 
Output:- 



 
 

 
 

Applications/Advantages of MapReduce: 

MapReduce is a programming paradigm that enables massive scalability across hundreds or 

thousands of servers in a Hadoop cluster. As the processing component, MapReduce is the 

heart of Apache Hadoop. The term "MapReduce" refers to two separate and distinct tasks that 

Hadoop programs perform. The first is the map job, which takes a set of data and converts it 

into another set of data, where individual elements are broken down into tuples (key/value 

pairs). 

 

The reduce job takes the output from a map as input and combines those data tuples into a 

smaller set of tuples. As the sequence of the name MapReduce implies, the reduce job is 

always performed after the map job. 

MapReduce programming offers several benefits to help you gain valuable insights from your 

big data: 

 Scalability. Businesses can process petabytes of data stored in the Hadoop Distributed 

File System (HDFS). 

 Flexibility. Hadoop enables easier access to multiple sources of data and multiple 

types of data. 

 Speed. With parallel processing and minimal data movement, Hadoop offers fast 

processing of massive amounts of data. 

 Simple. Developers can write code in a choice of languages, including Java, C++ and 

Python. 



 
 

PROGRAM-11 

Title- Write steps for installing the pig in windows 10. 

Pig is a procedural language for developing parallel processing applications for large 

data sets in the Hadoop environment. Pig is an alternative to Java programming for 

MapReduce, and automatically generates MapReduce functions. Pig includes Pig Latin, 

which is a scripting language 

 

Pig Installation: 

 

Before proceeding you need to make sure that you have all these pre-requisites as follows. 

1. Hadoop Ecosystem installed on your system and all the four components i.e. DataNode, 

NameNode, ResourceManager, TaskManager are working. If any one of them randomly 

shuts down then you need to fix that before proceeding. 

 

2. 7-Zip is required to extract the .tar.gz files in windows. 

Let’s take a look at How to install Pig version (0.17.0) on Windows as follows.  

Step 1: Download the Pig version 0.17.0 tar file from the official Apache pig site. Navigate 

to the website https://downloads.apache.org/pig/latest/. Download the file ‘pig-

0.17.0.tar.gz’ from the website. 

Then extract this tar file using 7-Zip tool (use 7-Zip for faster extraction.  First we extract 

the .tar.gz file by right-clicking on it and clicking on ‘7-Zip → Extract Here’. Then we 

extract the .tar file in the same way). To have the same paths as you can see in the diagram 

then you need to extract in the C: drive. 

 

 
 

 

Step 2: Add the path variables of PIG_HOME and PIG_HOME\bin 

 

Click the Windows Button and in the search bar type ‘Environment Variables’. Then click 

on the ‘Edit the system environment variables’. 

https://downloads.apache.org/pig/latest/


 
 

 

Then Click on ‘Environment Variables’ on the bottom of the tab. In the newly opened tab 

click on the ‘New’ button in the user variables section. 

After hitting new Add the following values in the fields. 

Variable  

 

 

All the path to the extracted pig folder in the Variable Value field. I extracted it in the ‘C’ 

directory. And then click OK. 



 
 

 

Now click on the Path variable in the System variables. This will open a new tab. Then 

click the ‘New’ button. And add the value C:\pig-0.17.0\bin in the text box. Then hit OK 

until all tabs have closed 

 

 

 

Step 3: Correcting the Pig Command File 

Find file ‘pig.cmd’ in the bin folder of the pig file ( C:\pig-0.17.0\bin) 

set HADOOP_BIN_PATH = %HADOOP_HOME%\bin 

Find the line: 

set HADOOP_BIN_PATH=%HADOOP_HOME%\bin 

Replace this line by: 

set HADOOP_BIN_PATH=%HADOOP_HOME%\libexec 

And save this file. We are finally here. Now you are all set to start exploring Pig and it’s 

environment. 

There are 2 Ways of Invoking the grunt shell: 

 

Local Mode: All the files are installed, accessed, and run in the local machine itself. No 

need to use HDFS. The command for running Pig in local mode is as follows. 

pig -x local 



 
 

 

MapReduce Mode: The files are all present on the HDFS. We need to load this data to 

process it. The command for running Pig in MapReduce/HDFS Mode is as follows. 

pig -x MapReduce 

 

 

 

Applications of PIG: 

 

Apache pig has a rich set of datasets for performing different data operations like join, filter, 

sort, load, group, etc. 

 

Programmers must use Pig Latin language to write a Pig script to perform a specific task. Pig 

converts these Pig scripts into a series of Map-Reduce jobs to ease programmers’ work. Pig 

Latin programs are executed via various mechanisms such as UDFs, embedded, and Grunt 

shells. 

 

 

 

 

 

 

 

 

 

 



 
 

PROGRAM_12 

 
Title: Working with pig commands. 

 

Apache Pig is a high-level data flow platform for executing MapReduce programs of 

Hadoop. The language used for Pig is Pig Latin. 

 

The Pig scripts get internally converted to Map Reduce jobs and get executed on data stored 

in HDFS. Apart from that, Pig can also execute its job in Apache Tez or Apache Spark. 

 

Pig can handle any type of data, i.e., structured, semi-structured or unstructured and stores the 

corresponding results into Hadoop Data File System. Every task which can be achieved using 

PIG can also be achieved using java used in MapReduce. 

 

Basic pig commands: 

 
1. Fs: This will list all the file in the HDFS 

grunt> fs –ls 

2. Clear: This will clear the interactive Grunt shell. 

grunt> clear 

3. History: 

This command shows the commands executed so far. 

grunt> history 

4. Reading Data: Assuming the data resides in HDFS, and we need to read data to Pig. 

grunt> college_students = LOAD ‘hdfs://localhost:9000/pig data/college_data.txt’ 

USING PigStorage(‘,’) 

as ( id:int, firstname:chararray, lastname:chararray, phone:chararray, 

city:chararray ); 

PigStorage() is the function that loads and stores data as structured text files. 

5. Storing Data: Store operator is used to storing the processed/loaded data. 

grunt> STORE college_students INTO ‘ hdfs://localhost:9000/pig_Output/ ‘ USING 

PigStorage (‘,’); 



 
 

Here, “/pig_Output/” is the directory where relation needs to be stored. 

6. Dump Operator: This command is used to display the results on screen. It usually 

helps in debugging. 

grunt> Dump college_students; 

7. Describe Operator: It helps the programmer to view the schema of the relation. 

grunt> describe college_students; 

8. Explain: This command helps to review the logical, physical and map-reduce 

execution plans. 

grunt> explain college_students; 

9. Illustrate operator: This gives step-by-step execution of statements in Pig Commands. 

grunt> illustrate college_students; 

Intermediate Commands 

 
1. Group: This command works towards grouping data with the same key. 

 

grunt> group_data = GROUP college_students by first name; 

 

2. COGROUP: It works similarly to the group operator. The main difference between 

Group & Cogroup  operator is that group operator usually used with one relation, while 

cogroup is used with more than one relation. 

 

3. Join: This is used to combine two or more relations. 

 

Example: In order to perform self-join, let’s say relation “customer” is loaded from HDFS tp 

pig commands in two relations customers1 & customers2. 

 

grunt> customers3 = JOIN customers1 BY id, customers2 BY id; 

 

Join could be self-join, Inner-join, Outer-join. 

 

4. Cross: This pig command calculates the cross product of two or more relations. 

 

grunt> cross_data = CROSS customers, orders; 

 

5. Union: It merges two relations. The condition for merging is that both the relation’s 

columns and domains must be identical. 

 

grunt> student = UNION student1, student2; 

 



 
 

Application: 

Programmers who are not good with Java, usually struggle writing programs in Hadoop i.e. 

writing map-reduce tasks. For them, Pig Latin which is quite like SQL language is a boon. Its 

multi-query approach reduces the length of the code. 

So overall it is a concise and effective way of programming 

All the scripts written in Pig-Latin over grunt shell go to the parser for checking the syntax 

and other miscellaneous checks also happens. The output of the parser is a DAG. This DAG 

then gets passed to Optimizer, which then performs logical optimization such as projection 

and pushes down. Then compiler compiles the logical plan to MapReduce jobs. Finally, these 

MapReduce jobs are submitted to Hadoop in sorted order. These jobs get executed and 

produce the desired results. 
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